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Licence Agreement
This licence agreement applies to ForestGALES version 2.1

You should carefully read the following terms and conditions before using this software.
Your use of this software indicates your acceptance of this licence agreement and warranty.

You shall not alter, modify or reverse engineer the original software or give anyone else
permission to do so. Unregistered use of ForestGALES after the beta-testing evaluation
period will be in violation of UK and international copyright laws.

Disclaimer of Warranty

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE DISTRIBUTED ‘AS IS’ AND WITHOUT
WARRANTIES AS TO PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES
WHETHER EXPRESSED OR IMPLIED. In particular, there is no warranty for the predictions made
by the model as they are regarded as indicative and not prescriptive.

NO RESPONSIBILITY FOR LOSS OCCASIONED TO ANY PERSON OR ORGANISATION ACTING,
OR REFRAINING FROM ACTION, AS A RESULT OF ANY MATERIAL IN THIS PRODUCT CAN
BE ACCEPTED BY THE FORESTRY COMMISSION.

ForestGALES is a PC-based program that has been designed to work under all Microsoft
Windows Operating Systems. Because of the various hardware environments into which
ForestGALES may be put, NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS
OFFERED.

The installation disks have been thoroughly tested for computer viruses with the latest virus
checking technologies available at the Forestry Commission. However, the user must assume
the entire risk of using the ForestGALES program and therefore nobody apart from the user
will be responsible for the loss of critical data or any other damage to the systems as a result
of virus attack or a malfunction of the program.

Trademarks

All terms mentioned in this book that are known to be trademarks or service marks have
been appropriately indicated. The Forestry Commission cannot attest to the accuracy of this
information. Use of a term in this book should not be regarded as affecting the validity of
any trademark or service mark. Readers should contact the appropriate companies for more
complete information regarding trademarks and registration.
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Introduction

Why use ForestGALES?

Wind damage to forest stands results in both direct costs (additional cost of
harvesting) and indirect costs (loss of amenity, danger). Threat of wind
damage has restricted silviculture and led to the use of truncated rotations
with precautionary felling in anticipation of windthrow.

Forest managers therefore require guidance on the timing and magnitude of
wind damage. A number of risk-minimising strategies can be applied (see
Quine et al., 1995) but these may be costly and so are best carried out only
where the risk is high. The strategies can involve operations within individual
stands (typically 1-20 ha), or the layout of stands at the forest scale (areas up
to 50 000 ha). A sound choice between techniques which may influence the
risk of damage such as type of cultivation, thinning, sequence of felling, is
most likely where prediction of their effects is possible. Research into both
prevention and prediction of damage has been carried out for nearly

30 years and this past work has been drawn together to provide ForestGALES
as a tool to guide forest managers.

The degree of constraint posed by strong winds in
Britain

Wind damage is a serious problem in forests planted on exposed sites in
Britain and western Europe. It is believed to cost the countries of the EU more
than €15 million per year, and in extreme cases substantially more. Five
‘catastrophic’ storms have affected British forests since 1945, emphasising the
frequency and scale of the problem — these include the storms of 1998 in
south Scotland, 1990 in south-west England and south Wales, 1987 in the
south-east of England, 1968 in the central belt of Scotland, and 1953 in
north-east Scotland. In each case over 1 million cubic metres of timber was
damaged, and up to five times the normal annual cut for the affected region
required harvesting. In 1999, storms damaged more than 190 million cubic
meters of timber in continental Europe and in 2005 storms damaged more
than 80 million cubic metres of timber across Northern Europe. Lesser storms
also cause some wind damage in most years, and their combined effect is a
serious constraint in upland forests. Windthrow has been the main form of
damage, but wind snap can be locally important when trees are particularly
well anchored or the crowns are loaded with wet snow.

Historical context — previous predictive windthrow
model

Until recently choices of windthrow-minimising strategies were guided by the
windthrow hazard classification ((WHC): Miller, 1985) which provided a method
to zone forest areas of 500 ha or more by adding scores for windiness and soil
together to estimate a hazard class. Each class was associated with a critical
and a terminal height (see Table 1.1) which respectively indicated the heights
at which damage was expected to start and to reach a level necessitating
clearance. The WHC provided a successful basis for comparing sites and
guiding decisions on thinning, but did not predict the timing or amount of
damage with acceptable accuracy (Quine and Bell, 1998). It was based on
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Introduction

subjective weighting of the influence of strength of wind and inadequacy of
rooting on the timing of wind damage. While this synthesised understanding
in the 1970s it could not be readily updated to incorporate new knowledge.

Research since the WHC was devised has improved understanding of root
anchorage (Coutts, 1983; Coutts, 1986; Nicoll et al 2006), turbulence
(Gardiner et al., 1997), adaptive growth (Nicoll and Ray, 1996), and wind
climate (Suarez et al., 1999). While it was possible to incorporate such
advances in qualitative advice (Quine et al., 1995) a new system was needed
to treat wind risk quantitatively.

Table 1.1

Critical and Terminal heights for each of the six classes defined by the Wind
Hazard Classification.

Critical height (m) Terminal height (m)

Non-thin | Selective | Line thin | Non-thin | Selective | Line thin

1 Unconstrained by windthrow Unconstrained by windthrow
2 25.0 22.0 21.0 31.0 28.0 28.0
8 22.0 19.0 17.0 27.0 25.0 23.5
4 19.0 16.0 14.0 24.0 21.5 18.5
5 16.0 13.0 12.0 19.5 17.5 15.5
6 13.0 10.0 9.0 15.5 13.5 11.5

What does ForestGALES calculate?

ForestGALES calculates the probability of average trees being damaged
within a stand. Damage to the average tree will by implication mean that
the stand as a whole will be substantially damaged.

How does ForestGALES compare to the WHC?

ForestGALES estimates the chance (or probability) of windthrow or stem
breakage, rather than stating a precise height at which damage will occur as
in the WHC. Probabilistic predictions are more realistic than precise heights
since the occurrence of damaging winds varies from year to year, which has
a powerful influence on the occurrence and spread of damage.

The risk of damage is extremely dependent on the windiness of the site. In
the WHC the measure of windiness is much coarser than is used in
ForestGALES. This allows ForestGALES to discriminate several levels of risk for
trees in similar WHC classes.

For example, a crown thinned stand of YC 12 Sitka spruce planted on a deep
ploughed gley soil, with average drainage, where the DAMS score is 14, will
have a critical height of 19.0 m and a terminal height of 21.5 m. The
standard Forestry Commission yield models (Edwards and Christie, 1981)
indicate that the trees will reach 21.4 m top height at age 51 when the
return period for damage will be 7 years. On the other hand if the DAMS
score is 10, then the site will still have a WHC class of 4, yet the return
period for damage to a 51-year-old stand has increased to 200 years.
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What is new in ForestGALES 2

ForestGALES 2 represents a complete rewrite of the ForestGALES software.
The new software is a much more efficient and robust code, which is easier
to understand and to document. Furthermore, it allows much easier
integration with other modelling tools. The main part of ForestGALES (the
part that does the actual calculations) has been constructed as a stand-alone
dynamic link library (DLL). This means that all the functionality of
ForestGALES is available from any other programme. The creation of a DLL
has made it much easier for ForestGALES to be integrated with GIS software
such as ArcView. Currently trials are under way in a forest district on the use
of ForestGALES within ArcView. Following these trials a general release of a
ForestGALES add-on to ArcView will be made available.

Wind Climate

The most important change to the calculation of risk is the change to the wind
climate calculator. The calculation of the probability of a particular wind speed
occurring at a site is based on the DAMS score. Additional analysis of wind
climate data from Forest Research wind monitoring areas has suggested that the
wind climate calculator was pessimistic. The differences are most pronounced
at low DAMS scores but even at a DAMS value of 15 the new regression has
the effect of reducing the DAMS score by 2 to an effective score of 13.

This is the only change in the calculation of risk. Critical wind speeds remain
identical to ForestGALES 1.3 but the probability of these wind speeds
occurring is reduced.

Appearance

The appearance of ForestGALES has been improved to provide a more
consistent view and to provide for easier operation.

Defaults

There is now a Defaults button (Alt + D) that can be used to store the
current values as the default. Therefore, if the current soil is a brown earth
and the Defaults button is pressed then brown earth becomes the default
soil used in ForestGALES. This is particularly useful if one is consistently
working with a particular combination of species, cultivation and soil types.

Multiple Stands (Batch) Mode

The Batch operations have been substantially improved. Entering data in
Multiple Stands Mode now uses the same forms as for Single Stand data
entry and there are three versions of Multiple Stands Mode matching the
three methods of calculating risk (Predictions using field measurements,
Predictions using yield models, Predictions through time). Unlike the
previous version of ForestGALES it is now possible to use the yield models to
enter data or to calculate risk through time when in Multiple Stands Mode.
In all cases input data and results can be stored in files for later use.
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Export
There are improved export facilities in ForestGALES 2.1 allowing results to be

sent to Word® as a Doc or Rtf file in the Single Stand mode and to Excel® in
Multiple Stands Mode for display, storage and printing.
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Installing and Uninstalling

System requirements

ForestGALES will run on IBM compatible personal computers that have a
minimum of:

e Microsoft Windows operating system
e Pentium 133 megahertz (MHz) or higher processor
e 32 Mb of RAM
e CD-ROM drive
e 20 Mb of hard disk space if DAMS scores left on CD
(520 Mb for full installation)
e Super VGA (800 x 600) display or higher-resolution monitor with 256 colours

Recommended: Microsoft Excel/Word 97® or above to use data export facilities
Installing ForestGALES
To install ForestGALES:

1. Place the ForestGALES CD in the CD drive.
2. The program will automatically install.

If automatic installation does not occur, then:

3. Press the Start button.

4. Press Run.

5. Type D:\Setup.exe into the dialog box, which will appear (replace the
letter D with whatever drive letter corresponds to your CD-ROM drive).

6. Left click on OK.

By default the program will then be installed into the directory C:\Program
Files\Forest Research\ForestGALES_ver2_1 on the drive, although it may
be placed elsewhere if required. The installation program will automatically
place all the files where they are needed, and add an option to run
ForestGALES from the Programs bar.
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Uninstalling ForestGALES

To uninstall the program:

. Press Start.

. Choose Settings.

. Choose Control Panel.

. Choose Add/Remove Programs then select ForestGALES 2.1 from

A W IN =

the list of programs.
5. Left click on Add/Remove.

This will remove all the components and data files of ForestGALES 2.1, with
the exception of files created while using the program. Exceptions include
saved/exported data files and new yield models.

Running the model for the first time

Start the program from the Windows Start. After the initial welcome screen
you will be presented with the main menu window as shown in Figure 2.1.
Choose Mode, Single stand, Prediction using field measurements
and a new query form will appear as shown in Figure 2.2.

Set:
— Species to ‘Sitka spruce’
— Cultivation to ‘notched planting’
— Drainage to ‘Average’
— Soil to ‘Peaty Gley’
— Current spacing to 2.6 m
— Top Height to 18 m
—DBH to 19 cm
— DAMS score of 15

Press the Run button and the Return Period, Wind Damage Risk Status and
Critical Wind Speeds for overturning and breakage will appear in the
previously empty boxes at the bottom of the form. Return periods will be
200 years for both overturning and breakage. Change the top height to

19 m using the up arrow next to the top height edit box and press the Run
button again. The return periods will change to 53 years for breakage and
181 years for overturning. You are running ForestGALES!

The various options available for the model are explained in later sections of
this manual.
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Figure 2.1 The ForestGALES main menu.
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Figure 2.2 Query form for Single stand predictions using field measurements.
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How the Model Works

How does the model work?

The model uses data relating to individual trees to estimate the risk of
damage to stands of trees by answering three questions:

1. What force would be needed to uproot or break the tree?

2. What wind speed would create the force required to damage the tree
(i.e. what is the threshold or critical wind speed)?

3. What is the probability of the threshold wind speed being exceeded?

What force would be needed to uproot or break
the tree?

The model calculates the strength of the stem and the resistance of the tree
to overturning independently.

Stem strength is based on theoretical work regarding tree stems as
structures, and a knowledge of the wood strength and stiffness of different
tree species.

Resistance to overturning is based on an extensive database of tree pulling
experiments that relate tree characteristics to the load required to pull a tree
over. These experiments have been conducted on a range of soil and
cultivation types for many species. However in some circumstances no data
are available, so assumptions have been made to allow data to be
extrapolated. When this happens, a warning message box will appear and
the results should be used with caution. The effect of drainage intensity is
included in the calculation based on the average change in force needed to
pull over trees on well or poorly drained soils in comparison to soils with
‘average’ drainage.

What wind speed would create the force required
to damage the tree?

In ForestGALES the wind loading on trees is calculated from the drag the
forest exerts on the flow above the canopy. The drag is a function of the
wind speed and the aerodynamic roughness of the canopy which is
dependent on the crown size and the area of ground occupied by each tree.

Crown size is modelled using regressions based on the height and diameter
of the tree.

From a knowledge of the average wind loading on each tree and the

resistance to breakage and overturning, the wind speed that would just cause
the tree to overturn or break is calculated. This includes calculating the extra
force due to the overhanging weight of the crown and stem as the tree bends.
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How the Model Works

What is the probability of a damaging wind speed
occurring?

Having calculated the wind speed required to damage the tree, the
probability of such a wind speed is estimated.

The average windiness of the site is measured using the DAMS system,
which is based on location, elevation and exposure. However, average winds
are unlikely to damage the tree, and the risk of extreme winds that are
sufficiently strong to cause damage must be derived from DAMS using a
Weibull distribution.

This distribution is extremely sensitive, and small changes in the wind speed
required to cause damage can be associated with large changes in the
probability of damage occurring.

Having calculated the probability of damage, this is converted to a return
period for a damaging wind speed occurring. This is the average interval
between storms that are associated with damaging winds.

Wind Damage Risk Status provides a rough estimate of risk, ranging from

Status 1 (return period for damaging winds more than 100 years) to Status 6
(return period less than 10 years).
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Using ForestGALES

Running ForestGALES

There are several ways to start the program.

The easiest is to press Start, followed by Programs, ForestGALES 2.1,
ForestGALES. When this is done, the program will start and the main menu
(Figure 2.1) will load onto the screen.

ForestGALES has been designed as a complete Windows application. Menus

are easily accessible with the mouse in the top part of the main window, or

they can be accessed using pop-up windows, shortcut keys or speed buttons.
Operating modes

ForestGALES can be used interactively in two operating modes:

Single stand mode - calculates the risk for one particular stand.

Multiple stand mode - calculates the risk for a number of stands one

after another (batch mode).

There are three ways of making predictions within these modes:

Predictions using - calculates the risk of damage at a single

field measurements point in time from stand characteristics
defined by the user.

Predictions using - calculates the risk of damage at a single

yield models point in time from stand characteristics
contained in yield models.

Predictions through - calculates the risk of damage over a typical

time rotation from stand characteristics contained

in yield models.
Selecting a mode and opening a query form

Having started the program, to select a particular mode, left click on Mode
at the top of the main menu.

A menu will appear. Left click on the mode that you want, and the menu
will disappear, and a form will appear automatically.

Alternatively, a new form can be created using the shortcut buttons at the top
of the main window. The meaning of each shortcut button is indicated by a
hint message that appears when the mouse is positioned over the button.

It is possible to have several copies of a query form open at the same time.
This may be useful if you wish to compare alternative scenarios.

ForestGALES query forms

ForestGALES collects data from and writes results to query forms. The exact
layout of the form depends on the mode (single stand, multiple stands) in
which the model is being used and the type of prediction being made (using

version 2.1 ForestGALES @



Using ForestGALES

field measurements, using yield models, through time). Figure 4.1 shows the
layout of the form for Single stand predictions using field measurements.

Figure 4.1. Query form for Single stand predictions using field measurements.
The parts of this form are:
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Stand characteristics box — describes the soil, spacing, cultivation, drainage,
and (where appropriate) planting year.

Tree characteristics box — describes the size of the trees within the stand
being modelled.

Upwind edge effect box — states whether a new brown edge is present,
and, if so, the size of the gap created.

DAMS box - describes how windy the site is. DAMS can be entered directly,
calculated exactly, extracted from a pre-calculated data file for a particular
location or estimated roughly. The layout of the box depends on which
selection is chosen.

Controls box — allows the user to run the model, save inputs, load a saved
file, print results, close the form and obtain help.

Wind damage risk box — indicates the risk of uprooting or stem breakage
occurring, and the estimated return period.

The query forms for other modes are described in later sections of this manual.
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Navigating ForestGALES
Using the mouse to make selections

As the mouse is moved over the query form, any of the components can be
selected by clicking the left mouse button. If text boxes (such as Stand ID),
up/down boxes (such as spacing) or menu boxes (such as species) are
selected, then changes can be made to the box by either typing in text (for
the text and up/down boxes) or by selecting the arrow buttons at the right
edge of the box (for menus and up/down boxes).

When one of these boxes is selected then pressing F1 will result in Help
being displayed to describe the use of the box.

If the mouse is moved over one of the buttons then the appearance of the
button will change. Clicking the left hand mouse button will cause the
button on the form to be pressed. This can be used to Run the model, Print
the form, etc.

Using the Tab key

Pressing Tab causes the ‘focus’ to move through each of the controls in turn.
The appearance of focus depends on the type of control. For text boxes,
up/down boxes and menus the focus is indicated by the background
becoming blue. For the buttons, focus is indicated by a thin black border
and a black dashed box around the caption (and picture, if present) on the
button.

When a control has focus, pressing F1 will result in help being displayed that
relates to the control.

A control which has focus can also be edited, changed or activated as
follows:

Text boxes Edit using the keyboard;
(e.g. Stand ID)

Up/down boxes Edit using the keyboard;
(e.g. spacing)

Menu boxes Edit using the up & down keys;
(e.g. species)

Radio buttons Select using the up & down keys;
(e.g. windfirm/brown edge)

Buttons Use the Enter key to press the button.
(e.g. Calculate DAMS or RUN)
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Using shortcuts

Shortcuts allow a combination of the ALT key plus a letter to be used to
select an option.

The Alt + key shortcuts in the main menu are:

Alt + F Open File menu

Alt + M Open Mode menu
Alt + A Open DAMS menu
Alt + O Open Options menu
Alt + W Open Window menu
Alt + H Open Help menu

Within ForestGALES, the shortcut for a particular button is indicated by an
underlined letter in the button caption.

Getting help

Help can be obtained either by clicking on a Help button, selecting Help
from the main menu, or by pressing F1.

Pressing Help starts the help system — this allows the user to search for a
particular topic or keyword.

Pressing F1 will display help relating to the component that has focus

(usually the last item where you clicked the mouse). These help pages are
therefore ‘context sensitive’.
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Predictions using field measurements

Introduction

This is the standard type of prediction. It allows the user to calculate the risk
of damage based on the stand's mensurational characteristics at a single point
in time.

The user enters data that describe the site, the tree crop and whether or not a
new edge is present.

In individual stand predictions, pressing RUN will then calculate the
probabilities of damage occurring based on the selected options. Making
predictions for multiple stands is explained in Chapter 8.

The stand characteristics box

The stand characteristics box (Figure 5.1) allows you to describe the stand for
which you wish to calculate the risk of damage. The options are described below.

Figure 5.1 The Stand characteristics box.

Stand Characteristics

StandID  [ForestGALES

Cultivation |N0tched Flanting

Drainage |.fi‘n.verage

Lef L] Lo

Soll type |F'eaty Gley

f» Cument Spacing [m) 2B >
(™ Current Stocking [M/ha)

Options - Stand ID

An identification for the stand. Note: names longer than 25 characters will
not print correctly if a report is produced.

Options — Cultivation

The cultivation type of the stand. The options are grouped into three main
categories, which are shown in Table 5.1.
Table 5.1

Cultivation methods available within ForestGALES, indicating the pooling of
options used by the model. (Notched planting means no cultivation.)

Mounding Shallow ploughing Deep ploughing
Notched planting Shallow ploughing <45cm  Deep ploughing >45cm
Turf planting Scarifying Disc trenching

Moling Alternate single/double
Mound planting Contour ploughing

Complete ploughing
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Options — Drainage

This describes how well drained the site is. Poor drainage (due to blocked
drains), for example, results in increased risk of uprooting. The options are:

Average — site is ‘typical’
Poor drainage - site is much wetter than you would expect
Good drainage - site is much drier than you would expect
Options — Soil type
This describes the main soil type in the stand. The most important factor is

whether the soil is a peat, a gley, or a freely draining soil. The options are
shown in Table 5.2.

Table 5.2

Soil types available within ForestGALES, indicating the pooling of options used
by the model. ‘Other’ soils are currently treated like gleys.

Free draining Peats Gleys Other

Brown earth Juncus (Flushed Ground-water Rankers and
basin) bogs gley soils skeletal soils

Podzols Molina (Flushed Peaty gley soils Littoral soils

blanket) bogs

Ironpan soils Sphagnum (flat Surface-water Man-made soils
raised) bogs gley soils

Calcareous soils Unflushed
blanket bogs

Eroded bogs

Options - Current spacing

The average spacing between trees at the time of risk assessment. It must be
between 0.6 and 10 metres.

Options — Current stocking

The number of trees per hectare at the time of risk assessment. The user has
the choice between this option and the previous one.

@ ForestGALES version 2.1



Predictions using field measurements

The tree characteristics box

The characteristics of the average tree of the stand are entered in the Tree
characteristics box (Figure 5.2).

Figure 5.2 The Tree characteristics box.

Tree Characteristics
Species |Sitka Spruce Lj

| Top height of stand () [18.0 2

ean DEH [cm) 13.0 ,]

The options that can be selected from the Tree characteristics box are:
Options — Species

The main species in the stand. Options are:

Scots pine Douglas fir
Corsican pine Noble fir
Lodgepole pine Grand fir
European larch Sitka spruce
Japanese larch Norway spruce
Hybrid larch Western hemlock

Options — Top height

Top height (in metres) of the stand being assessed. This must be between
5and 75 m.

Options — DBH

Mean diameter (in cm) of the stand being assessed. This must be between
5 and 50 cm.
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The DAMS box

DAMS is a measure of site windiness. The greater the value, the windier the
site. Only values between 5 and 32 (the range of values found in Britain) will
be accepted by the model. If the DAMS score for the site is known then it
can be entered directly. If it is not known then it can be estimated, looked
up or calculated by the program. The DAMS box is displayed in Figure 5.3.

Grid References method

In the DAMS box, the user can select Grid Reference and then enter the
grid reference of the site; the DAMS score, if available, will be displayed. The
DAMS scores are supplied on a separate CD-ROM, and this must be installed
in the CD drive if the data are to be accessed.

Figure 5.3 The DAMS box.

DAMS
¢ Grd Reference  Calculation

jNmeED Spply.. | DaMS 5core]15 :1

Exact Calculation method

In the DAMS box, select Calculation then click the Apply... button. The
calculation box will appear. Selecting the Exact Calculation box

(Figure 5.4) will give the opportunity to calculate the exact DAMS score. The
Wind Zone for the location can be found using the map that is displayed
when View Map is pressed. Elevation is entered together with the Topex
values for each of eight compass directions (TOPEX is the angle to the
horizon in whole degrees in the particular compass direction, with values less
than zero being entered as zero). The resulting DAMS score can be copied
to the main form by pressing Apply, or discarded by pressing Cancel.

Figure 5.4 The Exact Calculation box.

DAMS Calculation

Rough Guess | Exact Calculation ]

[ Result
Wind Zone n 5 ViewMap. | DAMS 123
Elevation (m1 (200 & Chbtole :
i Topex . o
Apply
| Morth }EI : ] Soth ]l:l : ]

MothEast [0 %] Southwest [0 3 & Help
| =zt 1'3' ¢| Wisat ]D |

R i
| Soith East 1] ¥ Morthwest |0 = X Cancel

Ab|[AF|[4p
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Rough guess method

In the DAMS box, select Calculation then click the Apply... button. The
calculation box will appear. Selecting the Rough Guess box (Figure 5.5) will
give the opportunity to estimate the DAMS score. Select the options that
best describe the site based on region within GB, elevation, shelter and
aspect. Press Apply to copy the resulting DAMS score to the query form, or
Cancel to close the window without copying the value across. This method
is particularly useful for making general comparisons between sites.

Figure 5.5 The Rough Guess box.

DAMS Calculation ——

; Exact Calculation 1

Result
GB Region |#West & North Cosst Sootland & Islands w| || DAMS |23

Elevation *TDF' of Hill j Contralz
Shelter ilNeII Shefterad j (] &pply
Azpect 1-&” :L]

& Help

M Cancel

The upwind edge effect box

The Upwind Edge Effect box (Figure 5.6) is used to describe whether a new
non-wind-firm edge has been created adjacent to the stand being modelled.
Brown edges (i.e. edges that were originally not at the stand edge) are often
a place where wind damage starts. If a new edge has been created then the
Brown Edge button should be pressed. The size of the gap can then be
altered. The default value is 0 m. The effect of a gap increases with gap
width until the size equals 10 x mean tree height, after which the effect
remains at a maximum.

Figure 5.6 The Upwind Edge Effect box.

Upwind Edge Effect
(+ ‘Windfirm edge

" Brown edge - Size of gap [m) ] '31
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The controls box

The Controls box (Figure 5.7) allows the user to control ForestGALES. The
options are described below.

Figure 5.7 The Controls box.

B /- Runs the model using the selected values. Shortcut is Alt + R.

[ Bun /- Prints the current query form. Shortcut is Alt + P.

rink Form

Creates a report that contains all the information on the form. The
/ report can be printed or saved for later use. Shortcut is Alt + T.

& 1ol " Starts the Help system. Shortcut is Alt + H.

Help

& OpenFil " Opens a previously saved query form. Shortcut is Alt + O.
OpenFile

Saves a query form, so that it can be reused at a later date.
= '
SaveFle — Shortcut is Alt + S.

Ty Defauts Changes the default values in the registry to the ones included

in the query form. Shortcut is Alt + D.

X Close
= Closes the current query form. Shortcut is Alt + C.

The wind damage risk box

Model outputs are displayed in this box (Figure 5.8).

Figure 5.8 The Wind Damage Risk box.

‘wind D'amage Risk

Return period ‘wind Damage Risk Statuz Critical wind spesd
OVERTURNING |200 J [Status 1 [54 mph
12345E
BREAKAGE  [B3 @[ [slaus2 [50 roph wHE [5

Critical wind speed

The critical wind speeds (i.e. the lowest wind speeds that will cause
overturning or breakage) are presented. By default these are presented in
mph. Wind speed units can be changed in the Options menu.

Return period

The average length in years between wind speeds exceeding the critical wind
speed occurring at the site. This is the average interval between gales that
will damage the site. The statistical nature of the wind climate means that
strong winds with long return periods (i.e. 50 years) may occur within a few
years of each other. The occurrence of a damaging storm does not alter the
risk of further damage in subsequent years.
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Wind damage risk status

A measure of the risk of damage either by overturning or stem breakage.
Six classes of wind damage risk status exist. These are listed in Table 5.3.

Table 5.3

Wind risk status and associated return periods.

1 >100 years
100-50 years
50-33 years

2
3
4 33-20 years
5 20-10 years
6

<10 years

Unlike the Windthrow Hazard Class (WHC) classes, the risk status of a site
will change over time. If the risk status for stem breakage is greater than for
overturning, then stem breakage is likely to be the predominant form of
damage, whereas if the risk status is greater for overturning than for
breakage then uprooting is likely to be the predominant form of damage.

Windthrow Hazard Classification (WHC)
The WHC class for the site, based on the ‘traditional’ system (Miller, 1985)

using the DAMS score and soil type. This is provided to allow comparisons to
be made between the old and new system.
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Introduction

This type of prediction allows the user to calculate the risk of damage at a
single point in time based on stand characteristics defined in yield models. It
is particularly useful when the mensurational characteristics of a stand are
not known or when wanting predictions made at a single point in the future.
Figure 6.1 shows the Predictions using yield models query form for single
stands. Making predictions for multiple stands is explained in Chapter 8.

A selection of yield tables is distributed with ForestGALES, and is stored in
the directory \yldmdls. To select a yield model, choose the species, then
select the yield class, thinning regime and initial stocking that apply. Only
the yield models which are available can be selected from the program. It is,
however, possible to create new yield models which can be used as input for
ForestGALES. This is described on page 6.3.

Figure 6.1 The query form for Single stand predictions using yield models.

{.'. Single stand predictions using Yield Models .
Stand Characheristics 1~ Tree Characteristics

StandID  [ForestGALES S ke ce I
Cultiveation |Notched Flanting j 5 Print Form
Drainage Average .
- I L ‘_1 @ Fepoit
Soil tupe |F’eaty Gley _:J | ield Class ]8 L]
Thinning regime ]men Thinning L] @ Help
Initial spacing [m] ]1.7 L] = Open File
I Planting year |14 - | Age b * HEDIRGL Save Filz
DAMS S L E g EfFc 14 Defeuks
(s Grd Reference ¢ Calculation & Windfirm edge -
NHBDIS0  Apply. | DaMSScore[15 & || © Brewnedge - Size of gap m) ] = X Close
R A Fetun DBIiOd wind Damage Riisk Status Crtical wind spead
DVERTURNING [200 | [Status 1 [E2mph
1234586E
BREAKAGE  |2mD  — {85 mph wHE [5

Stand characteristics box

As for Predictions using field measurements, the Stand characteristics box contains
the Stand ID, Cultivation, Drainage and Soil type options (see page 5.1).
The current stocking cannot be specified as this is taken from the yield tables.

Options - Planting year
A planting year can be specified. This will automatically adjust the stand age
to present in the Tree characteristics box. If you want to make a prediction

into the future adjust the age of the stand (see below) instead of specifying a
planting year.
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Tree characteristics box

When predictions are made using yield models, the Tree characteristics box
shows the same Species option as found in the Predictions using field
measurements (see page 5.3). However, the other options are different:

Options - Yield class

The thinning model regimes displayed will depend on the yield models
available (Edwards and Christie, 1981).

Options - Thinning regime

¢ Intermediate thinning with no delay

e Intermediate thinning with five year delay
¢ Intermediate thinning with ten year delay
e Line thinning

e Line thinning with five year delay

e Line thinning with ten year delay

e Crown thinning

e No thinning

Options - Initial spacing

The initial spacing (in metres, based on square planting) should be selected.
The range varies from 0.9-3.0 m depending on yield models available.

Options - Age

The age of the crop to be modelled. The valid range varies between yield
models. Ages between published values are calculated using linear
interpolation between the nearest younger and nearest older published
value. By default if the date of planting has been entered then the age of the
stand will be calculated. This will give the risk now. It is possible however to
change the date, allowing the risk to be calculated at some other time.

The ‘Tree Details’ button
If this button is pressed then the height, diameter, current spacing and

volume of the trees will be displayed. This is designed to provide information
about the type of stand being modelled.

Other boxes

The DAMS box, the Controls box, the Upwind edge effect box and the
Wind damage risk box are identical to those described on pages 5.4 to 5.7.
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User-defined yield models

New yield models can be constructed for use within ForestGALES using a
word processor, or spreadsheet program.

Overview

Currently ForestGALES doesn’t contain a user-defined yield model helper.
Yield models must therefore be created using a word processor or Excel®.
The general layout of the yield model file is described below. An Excel®
template is included with ForestGALES in directory yldmodils\userdefined
and is called yieldmodel.xls.

The format of the model is illustrated in Table 6.1 and is:

Line one: a header to describe what is in each field
Line two onwards: fields separated by a single space to define

e Age (years)

e Top Height (m)

e Stocking density (stems ha™)
e DBH (cm)

e Basal area (m*ha™)

e Mean tree volume (m?/tree)
e Volume per hectare (m’ha™)

In each case data refer to the main crop after thinning. This is the format of
the Forestry Commission Yield Models.

Table 6.1

Layout of a yield model for use in ForestGALES.

Age |Top height | Trees/ha| Mean [|Basal area| Mean tree | Volume
(years) (m) DBH (cm)| (m?*/ha) | volume (m®) | (m3/ha)
20 7.4 11 26 0.03 71

2781
25 9.2 2300 13 32 0.06 90
30 10.9 1900 15 38 0.10 120

Naming user-defined yield models
The file should be saved as a text file with a file extension of .yld.
If ForestGALES is to recognise the model then it must be named in a specific
way. This consists of an 8 character name.
1. The first two characters indicate species; these are shown in Table 6.2.

2. The second two characters refer to the yield class (02-30).

3. The third two characters refer to thinning regime, and are shown in Table 6.2.
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4. The final two characters refer to initial spacing in metres x 10. Therefore
0.9 m spacing becomes 09, and 2.1 m spacing becomes 21.

Table 6.2

Species and thinning codes for naming user-defined yield models.

Species | Species Thinning| Thinning regime
code code
SS Sitka spruce V4 Intermediate thinning no delay
NS Norway spruce IF Intermediate thinning five years delay
SP Scots pine IT Intermediate thinning ten years delay
LP Lodgepole pine LZ line thinning no delay
CP Corsican pine LF line thinning five years delay
EL European larch LT line thinning ten years delay
JL Japanese larch Ccz crown thinning
HL Hybrid larch NO non-thinning
DF Douglas fir T1 user-defined thinning regime
GF Grand fir T2 user-defined thinning regime
NF Noble fir T3 user-defined thinning regime
WH Western hemlock

A user-defined model for yield class 18 Sitka spruce for a non-standard
thinning regime planted initially at 2.0 m spacing would therefore be saved
as $S18T120.yld.

The file should be saved in the directory yldmdIs\XX\ where XX is the two
letter species code indicated in Table 6.2.

If a new model is created with an identical name to a model that already
exists, then the old model will be lost.

Using Excel® to create user-defined yield models

1. Open the file yieldmodel.xls in Excel®. It is in the directory
\yldmdls\userdefined\ wherever you have installed ForestGALES.

2. Type data for the yield model into the template.

3. Extra lines can be added as necessary. If the template contains more lines
than are needed, then remember to delete the extra lines.

4. Press File, Save As.
5. Choose the option Formatted Text(Space delimited)(*.prn).

6. The file must be saved in the directory XX, where XX is the two character
species code indicated in Table 6.2.

7. Type the filename according to the format described on page 6.3 to 6.4.
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Note: The filename must be enclosed in quotes (e.g. “$5201Z220.yld"), otherwise
the file extension .prn will be added resulting in a filename called something like
§5201220.yld.prn

8. Press Save.

The new model will be accessible within ForestGALES when a new Predictions
using yield models query form is opened.
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Introduction

This type of prediction allows the user to calculate the risk of damage to a
stand over part or all of its rotation, rather than at just a single age.

Figure 7.1 shows the Predictions through time query form for single stands.
Making predictions for multiple stands is explained in Chapter 8. The main
difference between predictions through time and predictions at a single
point in time is that the results are displayed on a separate form when the
model is run. Also, there is no option for modelling the effect of a new edge.

Figure 7.1 The query form for single stand predictions through time.

> single stand predictions through time . Tl =101
Stand Characteristics Tree Characteristics Controls
Stard 1D Species 1S|lka Spruce ﬂ [¥] Bun
Cultivation 1Notched Planting LJ & Frint Form
Drainage 1Average ﬂ i
Soil type ]Peaty Gley LJ “ield Clags ]B j
| Thinning regime ]Cruwn Thinning L] @ Help
Initial spacing [m] ]1 7 L} = OpenFile
Save File
DAMS 'f\(; Defaults
¢ Gnd Reference ( Calculation
1NH1 80150 Apply DAMS Seare 15 % X Close

Stand characteristics box
This is identical to the Stand characteristics box in Predictions using yield
models (see page 6.1) except that year of planting is not available, since
Predictions through time calculates risk over the whole rotation, not at just a
single age.

Tree characteristics box

This is identical to the Tree characteristics box described on page 6.2 except
that age is not available.

The DAMS box

This is identical to the DAMS box described on page 5.4.

The controls box

This is identical to the Control box described on page 5.6, except that a
report cannot be created.

User-defined yield tables

New yield tables can be constructed using the method described on page 6.3.

version 2.1 ForestGALES @



Predictions through time

Viewing the results

Figure 7.2 shows a typical results form. The form has four areas: a graphics
window, two tabular windows and a controls box. These are described below.

Figure 7.2 The Results form for single stand predictions through time.

| stand Predictions Through Time - ForestGALES - o i B3
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The graphics window

The graphics window indicates the return period in years for damaging
storms at intervals throughout the rotation. Typically as the trees grow older
and taller the risk of wind damage increases and the return period therefore
decreases.

The graph contains two lines. The red line indicates the risk of overturning,
and the blue line indicates the risk of stem breakage. The data relate to
average trees (i.e. with mean diameter and height) based on the yield tables.

Details of the graph can be investigated as follows:
Zooming into the graph:

¢ Place the mouse cursor at the top left hand corner of the area you wish to
zoom in to.

¢ Hold down the left mouse button.

e With the mouse button held down, move the mouse to the lower right
hand corner of the area you wish to zoom in to.

® Release the mouse button.

e The display will then change to the selected area.

Note: there is a minimum area which can be selected, and if a smaller area is
selected then no zooming will occur.
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Scrolling around the graph:

e Place the mouse cursor somewhere on the graph.

e Hold down the right mouse button.

e With the right button held down, move the mouse.
e The graph will move as you do this.

Resetting the graph:

e Place the mouse cursor on the graph.

Hold down the left hand mouse button.
With the left button held down move the mouse to the left and upwards.
e The display will then revert to the original state.

Note: there is a minimum area which can be selected, and if a smaller area is
selected, then the graph will not reset.

Displaying new results:

The effect of changing the yield model used can be observed directly in the
graphics window. Go to the query form, change any parameter, press the
Run button and the graphics display will change. This allows the user to
easily observe the effect of changing the thinning model or soil type or
species, for example.

The tabular data windows

The table window on the left hand side indicates how return period changes
with age, and provides details on height, diameter, spacing and volume of
the crop with age. The date when the crop enters each Wind Damage Risk
Status (WDRS) is displayed in the table window on the right hand side. Data
can be exported as described on page below.

The results form controls box
The controls that can be used on the results form are:

Print Form Prints the current query form. Shortcut is Alt + P.

Report Creates a report that contains all the information on the
form. The report can be printed or saved for later use.
Shortcut is Alt + T.

Help Starts the Help system. Shortcut is Alt + H.

Excel® Export Allows the user to export the tabular results to Excel®.
Shortcut is Alt + X.
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Introduction

ForestGALES has been designed to allow batch files of data (Multiple stands)

to be processed, in addition to assessing the risk to stands one at a time. This
allows data for a whole forest, property or coupe to be stored and calculated
together.

In this mode, data are read in from one file, and output to a different file. This
can be very helpful if a large number of stands need to be assessed at a single
time. Those stands would not necessarily have to be linked to each other as
the calculations are made independently. The Multiple stands mode can be
used with each type of prediction.

The interface of ForestGALES in Multiple stands mode is different from that
used for individual stands, and contains input and output areas as well as the
control panel. Figures 8.1-8.3 show the interface for each type of prediction.

Figure 8.1 The query form for Multiple stand predictions using field measurements.
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Figure 8.2 The query form for Multiple stand predictions using yield models.
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Figure 8.3 The query form for Multiple stand predictions through time.
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Input files can be created using the Multiple stands helper window that
appears in front of the query form when working in the Multiple stands mode
(see Figure 8.1-8.3). The input files can also be created from a spreadsheet.

However, since special codes are needed for some parameters, the use of the
Multiple stands helper application is recommended.
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The

multiple stands helper

The multiple stands helper allows the user to select inputs from menus, and
these are then written to the input area of the query form. This is useful
because ForestGALES uses coded values to describe the species, site and
cultivation rather than descriptions, and these values may be difficult to
remember. For each prediction type, the options are identical* to those
described for the corresponding query form in the Single stand prediction
mode (See Sections 5, 6 and 7).

Note: Clicking on Close causes both the helper and the Multiple stands query
form to be closed. Unless you want to discard the inputs, click on Calculate
Risk before closing the helper.

*There is a slight difference when making predictions for multiple stands
using yield models. The year at which you wish to calculate the risk has to
be specified on the query form rather than in the helper.

The controls box

The

The controls in the Multiple stands helper are:

Add Adds the selected values to the input area of the query form.
Shortcut is Alt + A.

Print Form Prints the current query form. Shortcut is Alt + P.
Help Starts the Help system. Shortcut is Alt + H.
Defaults Changes the default values in the registry to the ones

included in the query form. Shortcut is Alt + D.

Close Closes both the helper and the query form. Shortcut is
Alt + C.

multiple stands query form

The characteristics of the stand are entered in the input area. All data
relating to a single stand are displayed on the same line. After running the
program, the results of the model are displayed in the output area. If the
data have been saved then the filename will be displayed at the top of the
output area. The outputs vary slightly depending on the mode you are
running in (see Table 8.1).
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Table 8.1

Modes available for multiple stand predictions

Predictions Using
Field Measurements

Predictions Using
Yield Models

Predictions
Through Time*

*Double clicking on any of

Return Period for Overturning, Wind Damage Risk Status for
Overturning, Return Period for Breakage, Wind Damage Risk
Status for Breakage.

Model Used, Current Top Height (m), Current DBH (m),
Current Spacing (m), Return Period for Overturning, Wind
Damage Risk Status for Overturning, Return Period for
Breakage, Wind Damage Risk Status for Breakage.

Model Used, Age to reach WDRS 4 for overturning, Age to
reach WDRS 5 for overturning, Age to reach WDRS 6 for
overturning, Age to reach WDRS 4 for breakage, Age to reach
WDRS 5 for breakage, Age to reach WDRS 6 for breakage.

the input lines in this mode will open the graphics display window as for

a single stand. In this way it is possible to observe differences between the risk for all the stands

entered as inputs.

The controls box

The controls in the Multiple stands query form are:

Calculate Risks

Delete Row

Open File

Save Inputs

Save Outputs

Help

Excel® Export

Runs the model using the selected values. Shortcut is Alt + R.

Deletes a row of data from the input area. Shortcut is Alt + E.

Opens a previously saved query form. Shortcut is Alt + O.

Saves the input file for later use. Shortcut is Alt + N.

Save the output file so that it can be exported to another
application. Shortcut is Alt + U.

Starts the Help system. Shortcut is Alt + H.

Allows the user to export the tabular results to Excel®.
Shortcut is Alt + X.

Year of calculation

When you are in the Predictions Using Yield Models mode then the option is

provided to modify the Year of Calculation in the bottom right corner. The

default is the current year but any year in the past or future (up to 2100)

can be chosen. If the age is less than the minimum in the yield table the

model defaults to the minimum age. If the age is beyond the maximum age

in the yield tables the model defaults to the maximum age.

ForestGALES
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Single stand predictions using field measurements -
getting started

1. Start ForestGALES.
2. Left click on Mode
= The Mode dialog box will open.
3. Choose Single stand, Predictions using field measurements
=> A new query form will open. This form has a range of pre-selected
options. However, no value will be present in the Wind Damage Risk
box.
For the purpose of this exercise, make sure the default options are set to
the following values: Cultivation Notched planting, Drainage Average,
Soil type Peaty Gley, Current spacing 2.6 m, Species Sitka spruce, Top
height of stand 18 m, Mean DBH 19 cm, DAMS Score 15. Windfirm edge.

4. Left click on Run

= Values of 200 years will appear in the Wind Damage Risk box for the
return period for both overturning and breaking.

5. Left click on the up button to the right of the Mean DBH box
= The DBH will increase by 0.1 cm per 'click'.

6. Keep changing the DBH in this way until a value of 25 cm appears in the
box.

7. Change Top height until it reads 21 m.
8. Change Current Spacing until it reads 3.8 m.
9. Left click on Run
= The values in the Wind Damage Risk boxes will change to 12 years for
Return period for overturning and 13 years for Return period for

breakage.

This indicates that the risk of damage changes rapidly with changes in DBH,
height and spacing. Other parameters can be changed in a similar way.

Single stand predictions using field measurements -
the effect of a new edge

This example shows how creating new edges affects the risk of damage.

1. Start ForestGALES and open a query form for Single stands predictions
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using field measurements in the same way as the previous example.
2. Using the pre-selected options, left click on Run

= This will give the return periods for damage for the default
parameters, and no new edge.

3. Left click on the Brown Edge button

= A black dot will appear on the button, and the value for size of
upwind gap will become black. Change the Size of gap to 400 m.

4. Using the pre-selected values left click on Run

=> The values in the Probabilities boxes will change and should become
4 years for Return period for overturning and 3 years for Return
period for breakage.

This indicates that the risk of damage is much greater if a new edge is
present, than if no new edge is present. The Gap size box will also have
changed to 167 m. This is 10 x the mean tree height. Gap widths greater
than this have no additional effect on stability.

5. Now try changing the size of the gap to 5 m and left click on Run
= The values in the Probabilities boxes will change and should become
13 years for Return period for overturning and 8 years for Return

period for breakage.

Again, try changing other options to see what happens.

Single stand predictions using yield models

This example shows how to use yield models to provide input data for the
model.

1. Left click on Mode
= The Mode dialog box will open
2. Choose Single stand, Predictions using yield models

= A new query form will open. This form has a range of pre-selected
options. However, no value will be present in the Wind Damage Risk
box.

For the purpose of this exercise, make sure the default options are set to
the following values: Cultivation Notched planting, Drainage Average,
Soil type Peaty Gley, Species Sitka spruce, Yield class 8, Thinning regime
Crown Thinning, Initial spacing 1.7 m, Age 37, DAMS Score 15.
Windfirm edge.
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3. Left click on Run
=> This will give the probabilities of damage for a stand of YC 8 Sitka
spruce, planted at 1.7 m spacing with a crown thinning regime at an
age of 37. The values in the Probabilities boxes will change and
should become 200 years for Return period for overturning and 200

years for Return period for breakage.

The size and spacing of the modelled trees can be viewed using the Tree
Details button.

4. Now change the age to 55 and left click on Run
=> The values in the Probabilities boxes will change and should become
75 years for Return period for overturning and 81 years for Return
period for breakage.
This indicates that the risk is increasing with stand age.

5. Now left click on the down arrow to the right of Thinning regime

= A menu of thinning options will appear as you move the mouse over
the options, they are highlighted in turn.

6. Left click on Intermediate with no delay
7. Left click on Run
= The values in the Probabilities boxes will change and should become
200 years for the Return period for overturning and 200 years for
the Return period for breakage.
Again, try changing other options to see what happens.
DAMS example

This example demonstrates the use of DAMS as an input for the model.

1. Start ForestGALES and open a query form for Single stands predictions
using yield models in the same way as the previous example.

2. Leave the options as they were in the previous example and left click on
Run

= This will give the probabilities of damage for a typical tree in a stand
of YC 8 Sitka spruce, planted at 1.7 m spacing with a crown thinning
regime at an age of 37. The values in the Probabilities boxes will
change and should become 200 years for Return period for
overturning and 200 years for Return period for breakage.

3. Within the DAMS box, use the up and down arrows to select 19 as the
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value of DAMS score. The higher the DAMS score the windier the site.
4. Leave the options as they are and left click on Run

= The return periods should change to 23 years for the Return period
for overturning and 57 years for Return period for breakage.

It should be apparent that relatively small changes in DAMS result in large
changes in calculated risk.

Again, try changing other options to see what happens.

DAMS - rough guess example

This example demonstrates using a rough estimate of DAMS as an input for
the model.

1. Start ForestGALES and open a query form for Single stands predictions
using yield models.

2. Within the DAMS box select the Calculation button then click Apply...
= A new form will appear.

3. Left click on the Rough Guess tab
= New options will appear.

4. Select GB Region Scottish & English Borders, Elevation Mid-Slope,
Shelter Exposed, Aspect West.

=> 18 will appear in the DAMS box Pressing Apply would copy this value
to the query form.

5. In the GB Region box, select Central Wales
= 17 will appear in the DAMS box.

Again, try changing other options to see what happens.

DAMS - grid reference example

This example demonstrates how to obtain the DAMS score for a specific grid
reference.

1. Start ForestGALES and open a query form for Single stands predictions
using yield models.

2. Within the DAMS box click the Grid Reference button. Press Apply...

= 15 will appear in the DAMS box. This is the value of DAMS for
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NH180150. If ForestGALES cannot find the DAMS data it will ask you
to locate it. The Find Files option in the Windows start-up menu may
be useful for this.
3. Type NY659932 in the Grid Reference box
4. Left click Apply
= 17 will appear in the DAMS box.
Again, try changing other options to see what happens.

DAMS - calculate DAMS example

This example demonstrates how to obtain the DAMS score for a location
based on ground measurements.

1. Start ForestGALES and open a query form for Single stands predictions
using yield models

2. Within the DAMS box select the Calculation button then left click
Apply...

= A new form will appear.
3. Left click on the Exact Calculation tab
= New options will appear. By default, 23 will appear in the DAMS box.
This would relate to a hill top site at 200 m elevation in the west of
Scotland. Pressing Apply would copy this value to the query form.
4. To change the location left click on View Map

=> This will cause a new window to appear.

5. Left click in the dark blue area in central Scotland (North West of the
Tay estuary).

6. Press OK

= The windzone value 3 should be placed into the Windzone box and
15 will appear in the DAMS box.

7. Select 100 in the Elevation box

= 13 will appear in the DAMS box.

version 2.1 ForestGALES @



Examples

Table 9.1 Example Topex values.
8. Enter Topex scores as shown in Table 9.1.

North 0 South
North-east 3 South-west
East 5 West
South-east 10 North-west

11. Left click Calculate
= 10 will appear in the DAMS box.

Again, try changing other options to see what happens.
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Anchorage

Brown edge

Centre of pressure

Coherent gusts

Critical wind speed

Critical height

Cultivation

Damping

DAMS score

DBH

Dominance

Drag area

Drag force

Drainage

version 2.1

The complex of mechanisms by which the root system and
soil resist the wind forces on the stem and crown.

An edge of a stand that was created by felling part or all of
the adjacent crop, rather than being a crop boundary since
the time of planting.

The average position in the crown of the tree where the
total force of the wind can be said to act.

Organised rotational motions in the air (= Vortices).

Threshold hourly wind speed above which the average tree
of a stand is expected to be overturned or snapped.

The top height of the stand at which damage was
expected to start within the WHC system.

The method of preparing the soil prior to tree
establishment. This may have been done by many means
such as ploughing, mounding or producing turves.

The processes by which oscillations are reduced in size and
tend to stop. Damping includes canopy clashing, canopy
drag through the air, and frictional movement of stem fibres.

Detailed Aspect Method of Scoring — a system for scoring
windiness derived from tatter flags and using
representation of location and terrain to calculate a score
(Quine and White 1993).

Diameter of a tree at 1.3 m above ground level.

The ‘social’ status of a tree within a crop. Five categories
are usually defined — dominant (trees with a crown entirely
within the canopy), codominant (trees with much of their
crown in the canopy), subdominant (trees with their crowns
generally below the canopy), suppressed (trees with small
crowns entirely beneath the canopy, which are gradually
dying from lack of light) and dead.

The surface area of the tree (canopy and stem) presented
to the wind. Drag area is reduced as wind speed increases,
due to streamlining of the tree.

The force on the tree caused by the pressure exerted by
the wind on the crown (= wind loading).

A description of site wetness; poor refers to a wet site

where rooting is severely restricted by a shallow watertable
— due to local topography or failure of/lack of installed

ForestGALES
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Frequency of

oscillation

Fulcrum

Gust

Hinge

Leeward

Lever

Modulus of elasticity

Modulus of rupture

Moment

Overturning moment

Risk (for a tree)

Risk status

Root architecture

ForestGALES

drainage system; good refers to better than average site —
due to topography (e.g. shedding slope) or good quality
intensive drainage network.

The number of sway cycles of the tree per second.

The position on the lee-side of the tree where the root
system pivots when the tree is bent by the wind (= hinge).

A rapid increase in wind speed over a short period of time
(seconds rather than minutes).

See Fulcrum.

The side of the tree facing away from the wind.

The distance between the point of action of a force and
the fulcrum.

A measure of stiffness. Modulus of elasticity is the load that
theoretically would be required to make a material double
(or halve) in length were it to behave perfectly elastically.
In practice timber generally stops behaving elastically when
its length changes by 1% and breaks when the change
exceeds 2%.

The force per unit area that is required to break a material
when a bending load is applied.

Force multiplied by distance (= torque).

The force on the tree multiplied by the distance from
where the force acts (the centre of pressure) to the
fulcrum, plus the additional moment due to the weight of
the over-hanging crown.

The probability in a particular year of the critical wind
speed being exceeded (see Vulnerability).

A measurement of the probability of the critical wind speed
being exceeded in a particular year, grouped into six
categories. Status 1: return period >100 years; Status 2:
return period 50-100 years; Status 3: return period 33-50
years; Status 4: return period 20-33 years; Status 5: return
period 10-20 years; Status 6: return period <10 years.

The appearance and structure of the root system,

particularly the number and arrangement in three
dimensions of the thickest roots.
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Spacing — Current

Spacing - Initial

Stocking

Terminal height

Thinning

Top height

Topex

Turbulence

Vortices

Vulnerability
(of a tree)

WHC

Wind loading

Windthrow hazard
classification

Windward

Wind zone

version 2.1

The average spacing between trees at the time of risk
assessment.

The average spacing between trees at the time of planting.

The number of trees per hectare at the time of risk
assessment.

The top height of a stand at which wind damage was
expected to reach a level necessitating clearance.

The removal of a proportion of the tree crop for silvicultural
or economic reasons. ForestGALES can extract data from
yield models categorised according to thinning regime and
initial spacing. The regimes used in the yield models are
non-thinning (no trees actively removed, though some may
die naturally), intermediate thinning (removal of trees from
throughout the crop, with the smaller trees being
preferentially removed), line thinning (removal of trees in
straight lines) and crown thinning (removal of trees that are
competing with the crowns of the highest quality trees).
Models have also been produced for delayed thinnings.

The average height of the 100 trees of largest diameter per
hectare, usually measured as the average height of the

largest diameter trees in a sample of 0.0Tha plots.

A measure of exposure based on the sum of the angles to
the horizon in eight compass directions.

The random variations in wind speed and direction.

See Coherent gusts.

The threshold wind speed required to blow over a
particular tree on a particular site.

See Windthrow Hazard Classification.

See Drag force.

A method to zone forest areas of 500ha or more by adding
scores for windiness and soil together to estimate a hazard
class. Each class was associated with a critical height and a
terminal height.

The side of the tree facing towards the wind.

A range of windiness categories for the whole of Britain. The

higher the wind zone the windier the climate on average.
Windzone boundaries are defined in Quine and White (1993).
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Yield class A commonly used expression of growth rate — defined as
the mean maximum annual increment that could be
achieved by the stand (units - m® ha'yr").
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